RENESANAS Quick Start Guide
RA/RX/RL78 Family

Motor Control Development Support Tool Renesas Motor Workbench 3.1.2
Quick Start Guide

Introduction

Renesas Motor Workbench is a development support tool for Renesas MCUs for motor control (for target
MCUs, see ‘1.3 Specifications’) that performs debugging and tuning of motor control programs. It provides
internal tools, Analyzer, Easy, and Tuner. This Quick Start Guide describes the procedure for Renesas Motor
Workbench from installation to execution. For each function of Renesas Motor Workbench, refer to the
following manual.

¢ Renesas Motor Workbench User's Manual (R21UZ0004)
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RA/RX/RL78 Family Motor Control Development Support Tool Renesas Motor Workbench
3.1.2 Quick Start Guide

1. Overview

1.1 About Renesas Motor Workbench

Renesas Motor Workbench is a tool that enables real-time reading/writing values of global variables of the
program executed on the motor control evaluation board connected to a PC via USB.

Table 1-1 Main functions of Renesas Motor Workbench

Function Overview

Analyzer o Starts when the “Analyzer” icon is clicked from Select Tool in Main Window.

e For global variables of the program executed on a board connected via USB, it can
write variable values”, and “display variable values in waveforms

“load variable values”,
in real time”.

Easy GUI e Starts when the “Easy” icon is clicked from Select Tool in Main Window.
e The GUI allows you to easily instruct drive and command values for programs executed

on a board connected via USB.

Tuner

USB.

e Starts when the Tuner icon is clicked from Select Tool in Main Window.
o Allows you to operate “measurement of peculiar parameter” and “auto-adjustment of
control parameter Not© of the motor for the program executed on a board connected via

Note: The program executed on the board must have the auto-adjustment function.

@ Renesas Motor Workbench  <RMT File>:: D:\Work\RAGT1_MRSSK2_SPM_LESS_FOC_TUNER_RV200\RAGT1_MRSSK2_SPM_LESS_FOC_TUNER_RV200.rmt -

File Option Help

Connection File Information
CcoMm COM3 v Clock RMT File RAGT1_MRSSK2_SPM_LESS_FOC_TUNER RV... 4/5/2023 2:54:08 PM

Status Connect —- USB Serial Device Map File

Configuration Select Tool

CPU RAET1
Motor Type Brushless DC Motor
Control Software for Tuner(Speed control)

Inverter RSSK for Motar Easy

Project File Path  D:\Work\RAGT1_MRSSK2_SPM_LESS_FOC_TUNER_RV200 v| Details

Name Date Modified Size
) RAGT1_MRSSK2_SPM_LESS_FOC_TUNER_RV200.rmt 2023/04/05 14:54:08 279 KB

Figure 1-1 Main Window of Renesas Motor Workbench

Renesas Motor Workbench assumes the following sample programs as the target.

The Sample program included in this package

The Sample programs provided by Renesas (downloadable from Renesas Web site)

User programs

R21QS0011EJ0102 Rev.1.02
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RA/RX/RL78 Family Motor Control Development Support Tool Renesas Motor Workbench

3.1.2 Quick Start Guide

1.2 System Requirement

1.2.1 Target System

Renesas Motor Workbench can be used on the motor control board connected to a PC via USB. There are
three types of boards depending on connection to the PC.

Type 1: Motor control inverter board that incorporates the communication function to the PC (isolated

type)

(ex.) Renesas Solution Starter Kit - Evaluation System for BLDC Motor (Motor RSSK)
Type 2: Motor control inverter board that connects to the PC with a communication board for tools Note

(ex.) Renesas Flexible Motor Control Kit - MCK-RAG6T2 (including a communication board for tools)
Type 3: Motor control inverter board that connects to the PC with a commercially available USB serial

conversion module (isolated type). In this case, use the built-in type communication library (see 4.

Communication Library.)

Note: Communication board for tools: MC-COM (Renesas, RTKOEMXC90S00000BJ) or W2002 (Desk Top

Laboratories Inc.)

Renesas Motor Workbench
s EERR

Host PC use

Type 1 (see Fig.1-3)

(ex.) Renesas Solution Starter Kit
Evaluation System for BLDC Motor (Motor RSSK)

CPU card

l

* Inverter board incorporates a

Communication library

communication circuit to a PC (isolated type).

Type 2 (see Fig.1-3)

(ex.) Renesas Flexible Motor Control Kit - MCK-RA6T2
(including a communication board for tools, MC-COM)

Motor control inverter board

Communication board
for tools —

w et

(MC-COM or W2002)
(isolated type)

Commercially available

USB serial conversion [— MCU
(isolated type) Built-in type

library

1
)
1
)
1
)
1
)
)
! module
1
1
1
1
1
1
1

L R

Figure 1-2 System configuration when using Renesas Motor Workbench
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RA/RX/RL78 Family Motor Control Development Support Tool Renesas Motor Workbench
3.1.2 Quick Start Guide

< Example of Type 1 > Renesas Solution Starter Kit - Evaluation System for BLDC Motor (Motor RSSK)

CPU card Inverter board (RTKOEM0000B100208B))

Output | Inverter circuit
4—/— voltage
division ] ] | T
Hole — )| e [ ) ¢ &/
sensor/Encoder Level | Driver {3} ! © ) U,
connector shifter 3-phase 1 - L .
complementary PWM y /W BLOC
(12V) motor
icati o Current
Corcnon;sgwcct:trlon 3 4—‘ detection [« | (24-48V)
s ifi Shunt resistor output
(CAN, SPI) % I
MCuU Overcurrent _ | Power supply
“ POY:H 8| Gaanvy
circui circui (24-28V)
Overcurrent detection
Host PC «
[— < Volume
E1,
E2 lite E— Switch
*) > > LED

When writing :
execution file Level i .
y P Communication
shifter l Digital isolator M
' circuit
* An emulator (E1 or E2 !

: Communication circuit (isolated tfgel

Lite) is required

externally, except for RA

MCUs. scl scl - usB
" RAST1 OPU card " Renesas Motor Workbench
incorporates J-Link OB. Communication cable connector o
(USB mini-B)
UsB -u
— HE
Host PC ) =

< Example of Type 2 > Renesas Flexible Motor Control Kit - MCK-RAG6T2

Hole sensor/Encoder

CPU board CPU card connector Inverter board
(RTKOEMA270C00000BJ)  connector ol (RTKOEM0000B12020B)J)
10 CN7
division

le—]
——] < N
Inverter circuit
0 3-phase complementary .
5 > PWM > _‘& g
P Gate Y 1 )|
5 > > Driver i —> ~ 4
—> o ?
H 9]
Current 1
(12v) UN/W =]
N ot
M motor
z g 7
icati vercurren
Communicatiof T MU e © detection [« I
connector |zz RA6T2 2 ircui Shunt resistor output
(cAN,sPI) [ o P

w
w
<

CNT |

12V Boost
Host PC V) Y (12-48V) _
9 5V Buck [

S| Power supply
¢ |Re§|§t§ nce
division

connector

7 2 o
el o [ < Volume
[—] < Switch
When writing —> P LED
execution file 'l—l'

SClI

Renesas Motor Workbench

Digital isolator Comn_\un{callon
circuit

Communication board for tools, MC-COM
i d type)

- mEE
Host PC ' = "
*included in the Kit

Note: The hardware configuration varies for each MCU. This figure is for explaining the system configuration
and is simplified in some parts. For details, refer to the documentation for each evaluation system.

Figure 1-3 Hardware configuration of Renesas Motor Evaluation System (example of Type 1 and 2 in
Figure 1-2)
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RA/RX/RL78

Family Motor Control Development Support Tool Renesas Motor Workbench

3.1.2 Quick Start Guide

1.2.2 Host PC

Table 1-2 System requirement for Host PC

Item Specification
PC Windows PC with a USB terminal
¢ Available disk capacity: 50 MB and more
¢ RAM: 4GB and more
e USB ports: 1 ch (USB 2.0)
(O] Windows10
.NET Microsoft .NET Framework 4.6.1 or higher
Application | Adobe Reader (required when using PDF documents and Report function)

1.3 Specifications

Table 1-3 Renesas Motor Workbench specifications

Item

Specification

Target system

Supporte | RL78/G1F, RL78/G14

d MCU RX13T, RX23T, RX24T, RX24U, RX26T, RX66T, RX72T, RX72M
RA4T1, RA6T1, RA6T2, RA6T3, RA8T1

Peripheral | UART 1 ch, DTC (excluding RA MCUs), Port: TXD, RXD

function

Communicatio | Target e Motor control inverter board with built-in type communication circuits (ex.
n function system Motor RSSK)
¢ Motor control inverter board connected with a communication board for
tools (ex. MCK-RABT2)
[Communication board for tools]]
— MC-COM (RTKOEMXC90S00000BJ, by Renesas)
— W2002 (by Desk Top Laboratories Inc. Note)
¢ Motor control inverter board connected with a commercially available
USB serial conversion module (isolated type) (built-in type
communication library is required.)
PC USB2.0
Internal Variable Maximum simultaneous selection: 255
function read/write
Waveform | ¢ Maximum simultaneous display: 12ch
display e Maximum number of data

— 1024 (Motor RSSK, when using a built-in type communication library)
— 100000 (when using a communication board for tools ‘MC-COM’)

Note: Desk Top Laboratories Inc (http://www.desktoplab.co.jp/)
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1.4 Supportive Information (Reference)

Renesas web pages provide colorful information on motor control as follows. The page “Even Beginners Can
Start Sensorless Vector Control Within One Day” introduces how to use Renesas Motor Workbench through
videos.

e Motor and Inverter Control Solutions

https://www.renesas.com/us/en/application/key-technology/motor-control-robotics/motor-control-
solutions

e Brushless DC Motor Solution - Permanent Magnet Synchronous Motor
* The authentication file for Renesas Motor Workbench can be downloaded here.
https://www.renesas.com/us/en/application/key-technology/motor-control-robotics/brushless-dc-
motor-solution

e Even Beginners Can Start Sensorless Vector Control Within One Day (including videos)
https://www.renesas.com/us/en/products/microcontrollers-microprocessors/rx-32-bit-performance-efficiency-
mcus/rx23t-rx24t-rssk

Development support Tool

ven Beginners Can Start Sensorless Vector Control Within One Day

Motor Control Evaluation System Introduction S

You can learn various functions of Renesas
Motor Workbench through videos.

Figure 1-4 Renesas web page “Even Beginners Can Start Sensorless Vector Control Within One Day”
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Jan.30.24 RENESAS



https://www.renesas.com/us/en/application/key-technology/motor-control-robotics/motor-control-solutions
https://www.renesas.com/us/en/application/key-technology/motor-control-robotics/motor-control-solutions
https://www.renesas.com/us/en/application/key-technology/motor-control-robotics/brushless-dc-motor-solution
https://www.renesas.com/us/en/application/key-technology/motor-control-robotics/brushless-dc-motor-solution
https://www.renesas.com/us/en/products/microcontrollers-microprocessors/rx-32-bit-performance-efficiency-mcus/rx23t-rx24t-rssk
https://www.renesas.com/us/en/products/microcontrollers-microprocessors/rx-32-bit-performance-efficiency-mcus/rx23t-rx24t-rssk
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3.1.2 Quick Start Guide

2. Installation and Execution

(Included in package)

(include) Communication
Renesas Motor Workbench library or Built-in type
Motor contro|[¢========---1 o
S ‘ rogram communication
. T P (Chapter 4.) library
- EER
(Build)
(Chapter 2.1) Download > Execution file |7L _________ '
|
[}
l > Map file '7| '
T )
(Chapter 2.3) Install (Chapter 3. ! '
l __________________ 3 Target |
' system '
|
(Chapter 2.4) Start software | \4
l ' see Fig.1-2)
[}
[}
! Communication
(Chapter 2.5) Authentication ! circuit (isolated —
! type) 43
| A
* : |
(Chapter 2.6) Write execution program | (Included in package) E
[}
l ' Sample program E
[}
[} [}
(Chapter 2.7 Load RMT file R el et - RMT file a i
|
| |
}
l E Execution file l%"- ----- 4
(Chapter 2.7.2) Load Map file ¢----4 (RFP: Chapter 2.6.2)
C USB
Connect host PC and evaluation
(Chapter 2.8) board
A 4
Operate Renesas Motor
(Chapter 2.9 Workbench Noe
(Chapter : .
2.10) Save RMT file and exit

Note: For how to operate each function of Renesas Motor Workbench, see Renesas Motor Workbench
User's Manual

Figure 2-1 shows the flow of the operation of Renesas Motor Workbench from installation to execution.
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RA/RX/RL78 Family Motor Control Development Support Tool Renesas Motor Workbench
3.1.2 Quick Start Guide

(Included in package)

(include) Communication
Renesas Motor Workbench (., . ___________] library or Built-in type
Motor control L
- rogram communlcatlon
B == P (Chapter 4. library
WL
(Build)
(Chapter 2.1) Download g Beoenile ,7L """"" !
|
[}
l > Map file l) '
T [}
(Chapter 2.3) Install (Chapter 3. ! '
l __________________ 3 Target :
! system |
|
(Chapter 2.4) Start software : \4
l l see Fig.1-2)
|
[}
! Communication
(Chapter 2.5) Authentication I circuit (isolated —
| Lo
! type) =
| 4
v : :
(Chapter 2.6) Write execution program | (Included in package) E
[}
l E Sample program E
] [}
(Chapter 2.7 Load RMT file e el ettt - RMT file l) i
[}
] |
[}
I E Execution file l%—- ————— ]
(Chapter 2.7.2) Load Map file ¢----4 (RFP: Chapter 2.6.2)
c USB
Connect host PC and evaluation
(Chapter 2.8) -
A 4
Operate Renesas Motor
(Chapter 2.9 Workbench No®
(Chapter . .
2.10) Save RMT file and exit

Note: For how to operate each function of Renesas Motor Workbench, see Renesas Motor Workbench
User’s Manual

Figure 2-1 Flow from installation to execution of Renesas Motor Workbench
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RA/RX/RL78 Family Motor Control Development Support Tool Renesas Motor Workbench

3.1.2 Quick Start Guide

21

Download

Download Renesas Motor Workbench from the Renesas WEB. The downloaded file is compressed in .zip
file, so unzip it in advance.

2.2 Package Contents
The folder construction of the downloaded package and the file list of each folder are shown below.

communication library ...

ElfMapConverter ............

Installer

mot_rmt o

[ r20an0527ej0200-motor. pdf
[E r20an0527jj0200-motor pdf
[ r20an0528ej0200-motor. pdf
[E r20an0528(j0200-motor.pdf
& r21uz0004ej0300- motor. pdf
[ r21uz0004j0300- motor. pdf

(2) Map file conversion tool
(3) Installer and Authentication file

(1) Communication library (containing folders for each MCU)

(4) Execution file and environment file (containing folders for each evaluation board)

(5) Documents (The name and type of included documents may differ.)

Figure 2-2 Folder construction of package (after unzipped)

Table 2-1 File list in each folder

No. | Folder File Description
(1) | Map file generation | ElfMapConverter.exe Tool to generate a map file from elf file
tool of RA MCU.
(2) | Communication ICS_RX***.h File for RX MCU building
library (containing ICS_RX***.obj
folders for each ICS2 RX***h
MCU) ICS2_RX*** lib
Ics2_RL78G1F.h File for RL78/G1F MCU building
Ics2_RL78G1F.obj (containing folders for each compiler)
ICS2_RA**.0 File for RA MCU building
ICS2_RA™*_Built_in.o (ICS2_RA***_Buiilt_in.o is a built-in
ICS2_RA***.h type communication library)
(3) | Installer renesas_motor_workbench_****.msi | Renesas Motor Workbench installer
Authentication file renesas_motor_workbench_****.atf File to be loaded for authentication
(4) | Execution file and **** mot (RX) Execution file to be written into Motor
RMT file **** hex (RA) RSSK
(containing folders | **** rmt RMT file of Renesas Motor Workbench
for each evaluation (file that saves environment settings)
board)
(5) | Document r21uz0004ej****-rmw-um.pdf Renesas Motor Workbench User’'s
r21uz0004jj****-rmw-um.pdf Manual
r21gs0011ej****-rmw-qsg.pdf Quick Start Guide (this document)
r21gs0011jj****-rmw-qsg.pdf

R21QS0011EJ0102 Rev.1.02
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RA/RX/RL78 Family Motor Control Development Support Tool Renesas Motor Workbench
3.1.2 Quick Start Guide

2.3 Installation

To install Renesas Motor Workbench, execute installer “renesas_motor_workbench_***.msi” in the “Installer”
folder.

After the installer starts, follow the instructions on the screen and install it.

Double-click

]

= — | renesas_motor_workbench_*** . msi
b (*** indicates version No.)
ﬁ Renesas Motor Workbench — *

Welcome to the Renesas Motor Workbench Setup
Wizard

The installer will guide you through the steps required ta install Renesas Motor Workbench an pour ﬁ Renesas Motor Workbench _ %
computer.

Select Installation Folder il

The inzstaller will install Renesas Maotar warkbench ta the following folder.

Tainstall in this folder, click "Mext". To install to a different folder, enter it below or click "Browse"

WARMING: Thiz computer program is protected by copyright law and international treaties.

Unautharized duplication or distribution of this program, or any portion of it, may result in severe civil Falder:
or criminal penalies, and will be prosecuted to the maximum extent possible under the law, G¥Program Files (xB60¥Renesask lect onics¥Renssas Mator Wor Browse
Diisk Cost...
< Back Hest > Cancel Install Renesas Motor Workbench for vourself, or for anyone who uses this computer:
() Everyone
>
= (®) Just me
< Back Mext > Cancel
ﬁ Renesas Motor Workbench - X
) . _ <&
Confirm Installation (N
The installer iz ready to install Renesas Motor Workbench on your computer. ﬁ Renesas Motor Workbench — >
Click "Next" to start the installation. . -
Installation Complete Il
Renesas Matar Workbench has been successhully installed.
Click "Close" to exit.
< Back Meut > Cancel
g Pleaze use Windows Lpdate to check for any critical updates to the MET Framewark.
»

Figure 2-3 Installation steps

R21QS0011EJ0102 Rev.1.02 Page 10 of 55
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RA/RX/RL78 Family Motor Control Development Support Tool Renesas Motor Workbench
3.1.2 Quick Start Guide

2.4 Starting Software
When Renesas Motor Workbench is installed, a shortcut icon will be shown to a desktop. Double-click the

icon for “Renesas Motor Workbench” to start it.
r@

Renesas Motor
Workbench

Figure 2-4 Shortcut icon for starting

To start Renesas Motor Workbench from the Windows start menu, select “Renesas Electronics” > “Renesas
Motor Workbench”.

. Renesas Electronics

@ Renesas Motor Weorkbench

Figure 2-5 Starting from start menu

You can also start Renesas Motor Workbench by double-clicking a RMT file in the Windows Explorer. In this
case, it starts with the selected RMT file already loaded.

o
RABTZ_MCILV1_SP

M_LESS_FOC_TUN
ER_V100.rmit

Figure 2-6 Starting by double-clicking RMT file

If you cannot start Renesas Motor Workbench, installation might be failed. Uninstall and install it again
following the procedure described in the previous section.

R21QS0011EJ0102 Rev.1.02 Page 11 of 55
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RA/RX/RL78 Family Motor Control Development Support Tool Renesas Motor Workbench
3.1.2 Quick Start Guide

2.5 Authentication

2.5.1 First Authentication

When you start Renesas Motor Workbench for the first time, the message “Termfile not exist” may be shown
in the authentication screen. (While this message is indicated, you cannot use Renesas Motor Workbench.)

If the message is displayed, specify the authentication file (*.atf) in the “Installer” folder in the package from
the “Select” button and load it. When the authentication process is normally completed, the authentication
screen goes off, and Renesas Motor Workbench can be used now.

& Authentication - o x

Termfile not exist

Select Authentication File Select

Figure 2-7 Authentication screen (Termfile not exist)

2.5.2 Expiration of Authentication

Authentication for Renesas Motor Workbench has a time limit for one year. When the expiration date
approaches, the message “License expires soon” is displayed on the authentication screen. When it expires,
the message “Expiration date out” is displayed.

To continue using Renesas Motor Workbench, users need to acquire and load the latest authentication file to
update the authentication information.

From Main Window’s “Help” menu, select “Load Authentication File”, and the screen will be displayed as
below. Click the “Select” button to load the authentication file.

€ Authentication - o X

Set Authentication File

Select Authentication File Select

Figure 2-8 Authentication screen opened from Help menu (Set Authentication File)

2.5.3 Acquiring New Authentication File
To renew the time limit for using Renesas Motor Workbench, obtain the new authentication file (*.atf) from
the following Renesas web page and load it.
Renesas Motor Workbench
https://www.renesas.com/us/en/software-tool/renesas-motor-workbench

R21QS0011EJ0102 Rev.1.02 Page 12 of 55
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Renesas Motor Workbench & Downogdsovare

Solution Toolkit

B Motor Control Development Support Tool Renesas Motor Workbench 3.1
I8 Motor Control Development Support Tool Renesas Motor Workbench 3.1 Quick Start Guide
I8 Motor Control Development Suppart Tool Renesas Motor Workbench 3.1 User's Manual

Overview Downloads Documentation Design & Development Support Videos & Training Additional Details

& Overview

Description Features Release Information Target Devices

Renesas Motor Workbench (RMW) is a development suppeort tool for debugging, analyzing, and tuning motor control programs. It
operates 8 motor control program from a PC or acquires the data in the program to strongly support motor control development.

For Renesas Motor Workbench users (how to renew your license)

When starting this toal, the following messages regarding the license expiration date may be displayed.

License expire soon: The license will expire in less than 30 days.
Expiration date out: The license has expired.

81 Confirmation of — o x 81 Confirmation of .. = o x

License expires soon Expiration date out

To continue using this tool after the above message is displayed, you need to import the latest authentication file to update the
authentication.

How to renew license

1. Download the latest authentication file from the following link. Please answer a simple questionnaire to download.
Download authentication file
2. Click the "Select” button on the above messags screen and impaort the authentication file.

|

Download the authentication
file here.

Note: To download a file, you are required to log in the Renesas Web. After log in, follow the instructions on
the screen and download the authentication file.

Figure 2-9 Web page to download new authentication file

R21QS0011EJ0102 Rev.1.02 Page 13 of 55
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RA/RX/RL78 Family Motor Control Development Support Tool Renesas Motor Workbench
3.1.2 Quick Start Guide

2.5.4 Authentication Message

Authentication messages are automatically shown to the authentication screen according to the status in
which Renesas Motor Workbench starts. Table 2-2 lists the authentication messages and their solutions.

Table 2-2 Authentication messages and solutions

Message Status /Availability [Solution
Termfile not exist It is displayed when the requested | N/A Load the authentication file.
authentication information cannot
be found.
Set Authentication It is displayed when the “Load Available
file authentication File” item is selected
from “Help” menu.
License expires It is displayed when the license will | Available | To continue using the tool after
soon expire within 30 days. the expiration, acquire and load
Expiration date out | It is displayed when the license has | N/A the latest authentication file.
expired.
Expired File It is displayed when the loaded N/A If the status doesn’t change after
authentication file is invalid. reloading the file, acquire and
load the latest authentication file
again.
R21QS0011EJ0102 Rev.1.02 Page 14 of 55
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RA/RX/RL78 Family Motor Control Development Support Tool Renesas Motor Workbench
3.1.2 Quick Start Guide

2.5.5 Confirming Display of Main Window

When Renesas Motor Workbench starts after authentication, it displays Main Window and the dialog of
Select Navigation that supports the initial settings. (Since the initial settings can be configured later with
Select Navigation, you can close this dialog here by clicking the “Finish” button.)

Note: You can start Select Navigation from Help menu as well.

After confirming activation of Renesas Motor Workbench, prepare for connecting the evaluation board next.

@ Renesas Motor Workbench  <RMT File>:: D#Work¥RAST1_ESB_SPM_LESS FOC_E25 V101¥RAST1_ESB_SPM_LESS_FOC_E25 Viol.mt - o x
{ File Option Help
Connection File Information
com v Clock RMT File '
Status Map File
Configuration Select Tool
P < _

CPU

Motor Type
Control

Inverter

Welcome to the Select Navigation

We will support the settings required to use
Renesas Motor Workbench (RMW) in the future.
Click "Next".

El_i Project File Path

Details v |

Name

[] Do not show this features in the future
Al

>Rmt Select >End Assistance

Figure 2-10 Main Window view just after starting

Table 2-3 Names of each part in Main Window (No. corresponds to Figure 2-10)
No. | Name Function overview

1 | Menu ¢ Menu for File, Option, and Help

2 | Connection e Communication settings (selecting COM connection, communication clock,
display of connection status)

3 | Configuration ¢ Displays information on the connected target (CPU information, motor type,
control method, inverter name). (*This function is only for the execution
file provided by Renesas)

4 | File Information ¢ Displays information on the loaded RMT file and Map file.

¢ An RMT or Map file can be loaded by clicking the button on the right.

5 | Select Tool o Displays icons for the available tools. Click an icon to start the tool.

6 | Project File Path o Displays paths of the RMT files which were loaded most recently in a pull-
down list. (max. 10)

o Lists the RMT file in the folder specified here into File List.
7 | File List o Displays the RMT files in the folder specified by Project File Path.
e Double-click to load the RMT file into Renesas Motor Workbench.
8 | Select Navigation | e Specify various settings for Renesas Motor Workbench with the dialogue.
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2.6 Writing Execution Program

Write an execution file generated by building the project of the motor control program or the execution file
included in this package (.mot or .hex) into the target MCU. To write the file, use the tool such as IDE (CS+
or e? studio) or “Renesas Flash Programmer (RFP)”.

Note: The methods of connecting a PC to a CPU board and of supplying power differ between when the
execution program is being written and when Renesas Motor Workbench is being used. For details,
refer to the manuals for each evaluation system.

2.6.1 When building and writing sample program with IDE
This section describes how to write the sample program provided by Renesas Web by using Integrated

Development Environment (IDE), e? studio. (The RA MCU is used as an example here.)

For details on building, refer to the Application Note attached with the sample program.

(1) Importing project

Get the sample program from Renesas Web and import it into e? studio as the following steps.

e?studio @ import o %
Fie| Edit Novigate Seorch Project Rencsas Views
AltShitN > Select N,
Create new projects from an archive file or directory. : 4 g

ts from File System.

..| Select [File] -> [Import].
Renal
Ref

mmneommy »
b cu

Select an import wizard:

~ & General
I Archive File
CMSIS Pack

() File System

[] Preferences

(1 Projects from Folder or Archive

{2 Rename & Import Existing C/C++ Pr
T Renesas CC-RX project conversion t

Propertes. AltsEnter

[ UCs+
Code Generat,

Switch Workspace >

T Renesas C5+ Project for CATBKOR/CA

Select [Existing Projects
into Workspace] and click
[Next].

@, Sample Projects on Renesas Website

o Import... Ll Taw Renesas CS+ Project for CC-RX and CC-RL =
& Export @ Renesas GitHub FreeRTOS (with IoT libraries) Projet
i
v

Restart
Exit

=\
@

fext » Einish Cancel

& import o x|
Import Projects ey
Select a directory to search for existing Eclipse projects. / /
IE 1_E5B_5PMLESS, FOCEzs.vioT ] | Browse.
O Select archive file:
s
S| selectal
Deselect All
Refresh
\
opi
EQ Specify the folder of the
e

Working sets

[JAdd project to working sets

sample project and select the
project to be imported.

Click [Finish] to complete
importing.

Figure 2-11 Importing project (e? studio)
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(2) Setting toolchain

In the properties of the project, set the tool configuration for your environment.

Right-click on the target project

-5 RAGT1_ESB SPM L

Configure > A .
4 Binsries in Project Explorer and select
i Includes Source > p T
roperties].
Bra Properties Alt+Enter |/ [ p ]
o
C/C++Build> Settings > [Toolchain] tab C/C++Build > Settings > [Build steps] tab
8 Properties for RAST1_ESB_SPM_LESS_FOC_E25 V101 o X 8 Properties for RAGT1_ESB_SPM_LESS FOC_E25_V101 o X
Satings e o Setings G
Resource ~ Resource n
Builders. Builders
< C/C++ Build Configuration: | Debug [ Active] | | Manage Configurations. v C/C++ Build Configuration: | Debug [ Active ] ~ | | Manage Configurations.
Build Variables Build Variables
Environment Environment
Logging 1 Tool Settings & Toolchain | & Build Steps Build Artifact Binary Parsers @ Error Parsers. Logging ') Tool Settings &3 Toolchain +* Build Steps Build Artifact Binary Parsers @ Error Parsers
Settings. Settings.
Tool Chain Editor Name |ENU Tools for ARM Embedded Processors (arm-none-eabi-gec)  ~. Tool Chain Editor Pre-build steps
ARM (AArch32) v
Project Natures Architecture (AArct Project Natures ‘ v‘
Project References Prefix Project References Description:
Renesas QF Suffix l:l Renesas QF
Run/Debug Stings Rur/Debug Setings \ ]
Task Tags € compiler Task Tags.
et Validation Post-build steps
C++ compiler g+ Command(s):
Archiver ar E T Name] ]
Hex/Bin converter Confirm settings for Description: \
Listing generstor . [ \ -]
the tool chain. \
Size command
Build command make
Remove command m .
For RA MCUs, confirm that the
[Acreate flash image N o
[ create extende lising batch file to output a Map file is
E3prnt size registered in [Post-build steps].
[JEcho teol command
[AUse integrated toolchain version: [10.3.1.20710824
Per project path
o
v
) 2
@ [Apply and Close Cancel @ Apply 3nd Close Cancel

Figure 2-12 Setting toolchain

(3) Building

Build the project. Confirm that there are no errors in the build-result.

Project | Renesas Views Run Window Help Select [Projects] -> [Build projects] or click
Open Project os v R | ® - %~
Close Project
Open FSP Configuration
plorer >
[ Build Al Ctrl+Alt+B ESB SPM L 25 V10t
Build Configurations > |0 _— o
| Euild Project Ctrl+B El Console X
Build Working Set ? COT Build Console [RA6T1_ESB_SPM_LESS_FOC E25 V101]
Clean... Extracting support files...
Build Automatically 15:58:12 **** Build of configuration Debug fer project RAGTL_ESB_SPM_LESS FOC_E25 Viel ***%
make -r -jl12 all
&) Generate Javadoc... arm-none-eabi-size --format=berkeley “"RAST1_ESB_SPM_LESS_FOC_E25_viel.elf™
text data bss dec hex filename
C/Cr+ Index * 32044 148 3748 36832 8fed RAGT1_ESE SPM_LESS FOC_E25_V1el.elf
Update All Dependencies Alt+D
Change Device 15:58:12 Build Finished. @ errors, @ warnings. (took 229ms)
Change Teolchain Version
8 C/C++ Project Settings Ctrl+Alt+P
Properties
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(4) Writing into evaluation board

Connect a PC to the evaluation board with USB cable (when the CPU board has a J-Link interface), write the

program into the evaluation board.

Debug configurations > [Main] tab
Window Help ['® oebug Contiguratons o x

gnesas Debug Tools > Create, manage, and run configurations ﬁ\
Insdyction Stepping Mode

Line (C/C++) CReEX[EY - Name: [RAGT_ESE_SPV_LESS_FOC_£25 Vioi.elf ]

[type ilter text ||| [EXEER % Debugger| i Startup] & Source] [ Common
5] C/Cos Application

Resume X Line (C/C++)

ST o
Resume [E] C/C++ Remote Application =
i RA6T1_ESB_SPM_LESS_FOC_E25_V101 Browse.
Suspend o East sert [ J
[5] GDB Hardware Debugging C/C++ Application:

Terminate [ GDB Simulator Debugging (RHES0)
@ Launch Group

v [ Renesas GDB Hardware Debugging
(=R TESESPM LV
[ Renesas Simulator Debugging (RX, RL78)

[Debug/RAST £S5 SPVI_LESS PO E25 Vionof

Disconn Variables. Search Project. Browse.

Build (f required) before launching

Select [Run] -> [Debug
configurations].

O Disable auto build
Confiqure Workspace Settings.

Run to Line
T Use Step Filters Shift+Fs
@ Run Chrl+F11 Confirm that the target project to
45 Debug 1 debug is selected.
Run History >
(b} s > Filter matched 9 of 11 items Revert Apply.
Run Configugations... [
Debug Histhry >
4. Debug A >
| Debug Configurations... Debug configurations > [Debugger] tab
8 Debug Configurations. o x
Breakpoint Types >
Create, manage, and run configurations ﬁ
CFeRX[BY -~ Name: [RAGTI 55 FOC_E25 VioL.elf ]
ype filter text IHE > Startup| &, Source| (5] Common
[E] C/C++ Application
5] 1o+ Rermote Appiication Debug hardware: [F-LnkARM <] Torget Device: [RrraeTian___|
o EAsEscript
[£] GDB Hardware Debugging (GDB Settings  Connection Seftings  Debug Tool Settings
[ GDB Simulator Debugging (RHES0) 508 Connection Set
@ Launch Group. SIESIEDSENES
v [£7] Renesas GDB Hardware Debugging @ Autostart local GDB sejver Host name or [P address: localhost
[ RAGT1_ESB_SPM_LESS_FOC_E25 Viot.elf J— - -
[ Renesas Simulator Debugging (RX, RL78) Select the debugger. l & 1 Confirm the target device.
Connection
o8
GDB Command: [am-none-eabi-gdb Browse..| Variables.
[step Mode
: Addienal 60851 Click [Debug] to execute
; progr.am writing
Filter matched 9 of 11 items. Revert Apply
Confirm on the console @ o =
screen that [Download
is completed] . l
B Console X | 4! Reghsters| B3 Debugger Console| @ Memory [] ETEI R -]
RAGT1_ESB_SPM_LESS_JOC_E25_V101.elf [Renesas GDB Hardware Debugging] [pid: 24]
Finished target fonnection ~
GDB: 52955
Target connectjon status - OK
Target connectfion status - OK
Starting dow
Option Function Select, writing to address @x@@00480 with data FIFFFFfffffdffff
| SECHPUNxx, to address 88 with data FefFffffFffffffffcFFFfFFFFrFfFFf...
Finished download
[Hardware breakpoint set at address @x113@
v
< >

Figure 2-14 Writing program into evaluation board

R21QS0011EJ0102 Rev.1.02 Page 18 of 55
Jan.30.24 RENESAS




RA/RX/RL78 Family Motor Control Development Support Tool Renesas Motor Workbench

3.1.2 Quick Start Guide

(5) Disconnecting evaluation board

After writing the program, select “Run” > “Disconnect” to disconnect the evaluation board and remove the USB

cable.

| Run | Window Help

ReMegas Debug Tools

i#  InstructiomSteppinablad

Move to Line (O

Select [Run]-

Resume at Line (7| >[Disconnect].
B Resume Es
Suspend
B Termingle Cirl+F2
&4 Disconnect
Resume Without Signal
S Steplnto Fs
7% Step Over F6

}

& Console ¥ | &} Debugger Console

<terminated> RAGT1_ESB_SPM_LESS FOC_E25 W101.elf [Renesas GDY

GDB: 52955

Target cennection status - OK
Target cennection status - OK
starting download

Option Function Select, writing to
SECMPUxxx, writing to address @x2@008408 wi

Finished download

t_set at add

Disconnected from the Target Debugger.

<

Confirm on console
screen that the target
device is disconnected .

DB server (Host) (Terminated Apr 14, 2023, 5:23:45 PM) [pid: 24]

88460 with data FIFFFFFFFFFAFFff
data fcfffFffffiffifffcfrirfififfifif...

® % | B

&

@8 #a-5-=0

Figure 2-15 Disconnecting evaluation board

If the project has been rebuilt, load the Map file which was generated at the same time as the latest
execution file into Renesas Motor Workbench. For how to generate a Map file, see chapter 3, and for how to

load the file, see chapter 2.7.2.

Note: If executing the program (driving a motor) using Renesas Motor Workbench after writing the program,
use a communication dedicated circuit (isolated type) to connect to the target board.
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2.6.2 When writing with Renesas Flash Programmer (RFP)

This section describes how to write the execution file included in this package into the target board using
Renesas Flash Programmer (RFP). (You can download RFP from Renesas Web.) Configure settings for
communication to the CPU board according to the system to be used.

Load the RMT file that is included as well. (For how to load RMT files, see chapter 2.7.1.)

(1)
)

Launch the RFP tool and create a new project.

Specify the communication method and connect a PC and the target board.

Create a new project.

¥« Renesas Flash Programmer ¥3.11.01

File | Target Device

Help

Mew Project...

Unigue Code

Open Project...

Save Project

Save Image File...

File Checksum
Set File Password...

1RABT1_MRSSK2_SPM_LESS FOC _TU
2 RABT1_MRSSKZ_SPM_ENCD_FOC_TH
3 RABT1_ESB_SPM_LESS_FOC_EZ5 V1

Exit

St

s Create New Project

Project Information

Microcontroller:

RA

Name the project.

o

Project Name:

I F{F'.BT1_MRSSK2_5PM_LESS_FOO_TLINEF{_F{VEI

Project Folder: | Diork

| Browsze .

Communication

Toalk Interface:

Toal Detailz... Mum: AutoSelect

SWD w

Cancel

Fenesas Flash Programmer W3.1101 [6 Jan 2

- I

\ |

Select the connection to
the target.

Clear status and message

After connecting the target
board and a PC with the
communication method you
specified, click [Connect].

Figure 2-16 Writing execution program with Renesas Flash Programmer (1/2)
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(3) Specify the program to write and start writing.

(4) After writing is normally completed, terminate RFP and remove the target board from the PC.

Ee Renesas Flash Programmer ¥3.11.01

File  Target Device Help

Operation  Operation Settings  Block Settings  Connect Settings Unique Gode

Praject Information Specify the program to

Current Project: RABT1_MRS5KZ_SPM_LESS_FOG_TUNER_RV200rp) write

Mizracantroller: R (.mot or .hex).
Program File /
I|<PrDjECtDir>¥ RAGT1_MRSSK2 SPM_LESS _FOC_TUNER_RW200hex I Browsze..

GRG-32: ECB41BYF

\

Flazh Operation

Eraze »> Program > Werify

Connecting to the target device A ~
Connecting to the target device
Signature: After preparation,
Dievice: R click [Start].
Device Code: 00270447
Setting the target device
Dizconnecting the tool
Operation completed.
W
Clear statuz and mezsage
During writing / Writing is completed (normal termination)
= B Rensias Flash Progeammer V31101 - =
File TargetDevice Help Eik  TwqefDesce  Helg
Operation  Operation Settines  Block Settines  Gonnect Settines  Unigue Gode: Opmaton Oparstion Sattrgs  Block Gellines Cornect Satlings  Unsee Codn
Project Infor mation Pramet inlr reton
Current Project: RABTI_MRSSK2 SPM_LESS FOC TUNER_RV200rp; Cuament Project: RAAT1 MRS5S LESE FOO0_TUKER Svadimy,
Wl ) Nirecorirolir: R
Program File Pragran Fia
<ProjectDir¥RAGT1 MRSSK2 SPM_LESS FOC_TUNER_RV200hex Bronse. [CProiuctl S WRAATI_WPESEH3 MW LSS FOG: TURES, v Eroese.
CRC=20 - FCRAIRAF. QRO-31 - ECE4 1ESF
Progress Repor
Flash Cporal port ﬁ Flagh Cpemtion
Erase 5> F Runnine. . Ergee ¥ Progeam - Werity
— [ !
Start 0K
Erasing the selected blocks ~ [Cone feasl BETRRATEE - BRTERATEF  cioe: 15 -
[Code Flash 1] 0x00000000 - 0x0007FFFF  size: 512K
[Data Flash 1] 0x40100000 - 0x40101FFF  size: 8 K [esitving ot
[Doge Fleoh 110600000000 - (NNDFFF 5= 10K
iiriting data 1o the targst device [Donie Aessl BaETRIATEE - BETRRATIF  cze: 16
[Code Flash 1] 0x00000000 - 0x0000DFFF  size : 66 K [Satiing the taeges dessos
[Config Area] 0x0100A150 - 0x0100A16F  size: 16
ICssoonmaating: the ool
erityine cata operation compistoa
[Code k1] 000000000 - 0x0000DFFF  size : 56 K.
OClear status and message Cluar rishs ard marzags

Figure 2-17 Writing execution program with Renesas Flash Programmer (2/2)

Note: If executing the program (driving a motor) using Renesas Motor Workbench after writing the program,
use a communication dedicated circuit (isolated type) to connect to the target board.
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2.7 Loading Variable Information

Renesas Motor Workbench loads the Map file which is outputted in generation of the execution program and
gains access to the global variables. If the program has been changed and rebuilt, it is necessary to load the
Map file again.

Renesas Motor Workbench can save and load the variable information and environment information
including settings for tools as an RMT file (environment file).

Build a project
Renesas Motor Workbench

Tool setting information

Save

Load »  RMT file
Variable information
Load

Execution file Map file

A 4
A

74

Figure 2-18 Map file and RMT file (environment file)

2.71 Loading RMT File

When an RMT file (storing both variable information and tool setting information) is provided in the sample
program included in this package or in the sample program provided by Renesas, load the RMT file by following

one of the operations below.

(a) Use Select Navigation function (displayed from Help menu) and load the RMT file.

(b) Select “Open RMT File” of the Main Window’s File menu and load the RMT file.

(c) Click the “...” button next to the RMT File field in Main Window’s File Information and load the RMT
file.

(d) Specify the project folder in Main Window’s Project File Path and double-click the RMT file displayed
on the File List to load it.

(e) Drug & drop an RMT file on a PC to Main Window’s File List and doble-click to load it. (In this case,
the RMT file is copied to the project folder on the PC.)

Note that if the sample program has been changed and buiilt, it is necessary to load the Map file generated in
building into Renesas Motor Workbench again.
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Y —
& El

Welcome to the Select Navigation

We will support the settings required to use
Renesas Motar Workbench (RMW) in the future.
Click "Mext",

If you check this, the message
will not appear from the next
time.

| I ] Do not show this features in the future

Select RMT File

Select the RMT file you want to use and click "Next".
The RMT file is an environment file that saves various settings used in RMW.

Selecting RMT: RABT1_ESB_SPM_LESS_FOC_E25_V101.rmt

7]
A

Cpr——

. Select the Map file.
Select Map File

Select the MAP file and click “Next".

Selecting MAP: RA6T1_ESB_SPM_LESS FOC_E2S_V101_conv.map

Do not show this features in the future

< Back

—d

>RMT Select

>COM Select

—d

>End Assistance

Finish

. | Select the RMT file to load. |
MNext > Finish
et E
= Rmi Select ~End Assistance Do not show this features in the future
>
»
< Back Next > | Finish
S NE—
>Start >Confifmation >End Assistance
& SarctHavigation
&
<
Map File Select Confirmation
Do you want o select a MAP file?
RMT file is updated when map file is selected. Py—
| | If USB connection is
Yes I l Mo I P .
Select COM Port established, you can select a
AN COM port
If you want to load a Map file, click Select the COM port that communjcates with the ICS board and click "Next".
[Yes].
| Do nof| show this MESTITES TITIE TOTOTE Selecting COM:  COM3 v Clock
< Back Finish
_ —_— Click [Finish] to complete
=Select R} =Confirmation >End Assistance ttin
| Do not show this features in the future g3 &k
—>
—_——
Select MAP >Confirrhation >End Assistance
A 4

Completion to use RMW Tool

Wou have completod the nacessary settings 1o usa
Rervezas Motor Workberich (RIVIW)
Click " Firvsh and sabect the fabar you wand 1o s,

Click [Finish] to complete
setting.

00 P ST This TEATUTES in e Raure

=60l ASSISIANGH

Figure 2-19 @ Loading RMT file using Select Navigation function
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) Select [File] -> [Open RMT File], and
File Option Help — the dialog for loading RMT file will be
Open RMT File(O) displayed.
Save(s)
Save As(A)

Load Variable Data{M)
Exit(X)

Figure 2-20 @ Loading RMT file from “Open RMT File” of File menu

Click [---] button in File Information,
and the dialog for loading RMT file will
be displayed.

File Information

RMT File Iil

Map File

Figure 2-21 @ Loading RMT file from Main Window’s File Information

Project File Path | D:\Work\Renesas Motor Workbench_V3_1\mot_rmt\RA6T1_ESB_SPM_LESS_FOC_E2S V101 W | (:) Details v
Name Date Modified Size
E_ﬁ RA6T1_ESB_SPM_LESS_FOC_E25_V101.rmt 2023/04/13 13:21:47 414 KB
RA6T1 MRSSK2_SPM_LESS FOC_TUNER_RV200.rmt 2023/04/05 14:54:08 279 KB
A Select a project folder from the
/ Double-click to load the RMT pull-down list of the loading
/ file shown in the File List. history.
1
1
T
!
@
rasta s 55 ] You can also add the RMT file
M_LESS_FOC_TUN to File List by drag & drop.
ER_V100.rmt

Figure 2-22 @®) Loading RMT file from Main Window’s File List
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2.7.2 Loading Map File

When using a user program (when an RMT file doesn’t exist), you need to load a Map file into Renesas
Motor Workbench first.

You must use the Map file that was created at the same time as the execution file in building. If the program
has been changed and rebuilt, it is necessary to load the Map file again as well. For generating a Map file,
refer to “3. How to Generate Map File”.

Steps for loading Map file:

(1) Load a Map file by one of the operations below. (For how to operate, refer to the figures in 2.7.1
Loading RMT File.)

(a) Use Select Navigation function (displayed from Help menu) to load the Map file.
(b) Select “Load Variable Data” from the Main Window’s File menu and specify the Map file to load.
(c) Click the “...” button next to the Map File filed in Main Window’s File Information to load it.

For RX:
Load a file with a *.map extension.

For RA:
In the file selection dialog, select “All Files (*.*)” for file type, and load a file with a *.rmap extension. If
“MAP Files (*.map)" is selected for file type, a file with *.rmap extension is not displayed.

However, you can change the extension from *.rmap to *.map by the method described in the Tips of “3.3
[RA] In e2 studio Environment” or by modifying the extension directly. In this case, load the file with *.map
extension that you have modified without changing the file type in the file selection dialog.

& Load Variable Data X
<« v 4 « app » rmw v O

RX72T_ESB_SPM_LESS_FOC_CSP_V110.map 2

Tnd 2771 IOEEE
ERUET

774 WEN): | |MAP Files (*.map) v
MAP Files (*.map)

All Files (*.")

Figure 2-23 Map file selection dialog box

(2) After loading the Map file, “Use Setting Form” screen is displayed. If “Change in Data Type” or “Change
to Array” has been set in the Option Dialog (displayed by selecting “Option Dialog” from Option menu) in
loading, these settings are reflected to the list.
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@ User Setting Form

Address
1ffe0198
1ffe01a8
1ffellac
1ffe01f0

1ffe0lec

Name
g_f4_id_ref_monitor
g_f4_iv_ad_monitor
g_f4_iw_ad_monitor
g_f4_vdc_ad_monitor

g_f4_vd_ref_monitor

- O

Set

DataType
FLOAT
FLOAT
FLOAT
FLOAT
FLOAT

Figure 2-24 User Setting Form screen

You can also change the Data Type settings on the User Setting Form screen.

Address
1ffe0198
1ffe01a8
1ffe0lac
1ffe01f0
1ffe0lec

&) User Setting Form

Name

g_f4_id_ref monitor
g_f4_iv_ad_monitor
g_f4_iw_ad_menitor
g_f4_vdc_ad_monitor

g_f4_vd_ref_monitor

- O

Set

DataType
FLOAT

[UINTS

INT8
UINT16
INT16

UINT32
INT32
FLOAT

Figure 2-25 User Setting Form screen (change Data Type settings)

(3) When you press “SET” button, the variable information is loaded into Renesas Motor Workbench.

Note that after loading variable information by pressing “SET” button, you cannot change the Data Type
using the function of Renesas Motor Workbench. To make a change, load the variable information
with “Load Variable Data” function again.
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2.8 Connecting Host PC and Evaluation Board

To connect Renesas Motor Workbench to the evaluation board via USB, it is necessary that the variable list
(address information) of the loaded RMT or Map file should match the control program on the evaluation
board. If it doesn’t match, connection wouldn’t be established. In this case, follow the operations described in
chapter 0 and 2.7 again.

2.8.1 Connecting via USB
For system requirements when Renesas Motor Workbench is used, refer to chapter 1.2.

Supply power to the evaluation board with the program written and connect between a PC and the
evaluation board with a USB cable.

When they are connected normally, the connected “COM**” (** indicates the port number) is displayed in the
pull-down list for COM selection in the Main Window’s Connection. This means the status where COM
communication between the PC and the board is established and a communication can start.

Connection

COM v Clock

COM3
OffLineMode

Status
Select the connected COM port from

the pull-down menu.

Figure 2-26 COM selection list of Main Window’s Connection

2.8.2 Starting USB Communication
When you select “COM**” from the COM selection list, the communication connecting process starts. The
connecting process status is displayed in “Status”. When the connecting process is normally completed,
“Connect — USB Serial Port” will be displayed in “Status”. In this state, tools are enabled.

Connection
COM COM3 v Clock

Displays establishment of
Status | Connect -- USB Serial Device I/ connection.

Figure 2-27 Connection status view after connection establishment
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If an error message is displayed when you select “COM**” from the COM selection list, the causes could be
as follows; the USB connection may have a problem, the target board may not be turned on, or the
communication clock setting may be wrong.

Error

[Message]

Failed to COM connecticn.

[Solution]

Please reconnect after confirmation of connection cable, a board, a power supply
and Frequency Clock setting.

[Message Code]

1-1-31

QK Cancel

Figure 2-28 Error message under COM connection
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2.8.3 When using Communication Board for Tools (setting clock frequency)

When using a communication board for tools (MC-COM by Renesas or W2002 by Desk Top Laboratories),
specify the communication speed by the following operation.

Click the "Clock" button in Main Window’s "Connection" to display the Clock Setting dialog. The Clock
Setting dialog displays the clock frequency that is currently set, so you can change this value. The changed
clock frequency will take effect at the time of COM connection.

Gock s o

8,000,000| Hz
. o

Status Connect -- USB Serial Device )
Change the setting.

Connection

Figure 2-29 Clock Setting dialog

To set the clock frequency, obtain the value by multiplying the communication rate by 8.

Example:
When the communication rate is 1 Mbps, set the clock frequency to 8 MHz (8,000,000 Hz).
When the communication rate is 5 Mbps, set the clock frequency to 40 MHz (40,000,000 Hz).

When using a MC-COM (Renesas communication board for tools), you can select the following
communication rates (clock frequencies). Set it based on the jumper (JP2) of the MC-COM.

Table 2-4 Settings of MC-COM JP2 and selectable clock frequencies

JP2 Selectable clock frequency

Short 1 Mbps (8 MHz), 5 Mbps (40 MHz), 7.5 Mbps (60 MHz), 10 Mbps (80 MHz),
15 Mbps (120 MHz)

Open 6.25 Mbps (50 MHz), 8.33 Mbps (66666666 Hz), 12.5 Mbps (10 MHz),
16.66 Mbps (133333333 Hz)
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MC-COM board

| Jumper (JP2) I

. ENESAS
-3 RTKOEMXCS0Z000008J9
- MADE TN JAPAN |
PR Y]

Figure 2-30 JP2 of MC-COM (communication board for tools)

2.8.4 When using Built-in type Communication Library (setting baud rate)
When using the built-in type communication library, set the baud rate by the following operation.
Select "Baud rate Dialog" from Main Window’s "Option" menu to display the BaudrateSetting dialog. The

dialog displays the baud rate that is currently set, so you can change this value. The changed baud rate will
take effect at the time of COM connection.

Help

Change the setting.

/

Option Dialog

Baudrate Dialog Baudmtesjﬁg |
21,600| bps

Figure 2-31 Setting baud rate

Set the baud rate to the value that is set by the program including the built-in type communication library. In
addition, the set value must be a value that can be set to the connected USB serial conversion board from
the PC. You can check the configurable values in the properties of the COM port (port setting) from Device
Manager of Windows control panel.

2.8.5 In Case of USB Connection Trouble
If any problem occurs on USB connection, solve it by the following operations.

e Check the connection to the evaluation board and the power supply to the board.
¢ If no connectable COM is displayed, check the authentication status. (Select “Load Authentication
File” from “Help” menu and check the message on the authentication screen.)

¢ Confirm that the execution program of the evaluation board and the variable list loaded into
Renesas Motor Workbench are both generated in the same build.

¢ Reset the evaluation board, reconnect the USB cable, or change the USB port to another one, etc.
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2.9 Description of Operation

2.9.1 Launching Internal Tool

When a Map or RMT file is loaded and the target is connected normally, icons for available tools will be
shown in Main Window’s Select Tool. (The view of Main Window and available tools vary depending on the
sample program.)

Click an icon in Select Tool to start the tool, and the window for the tool will open.

(&) Renesas Motor Workbench  <RMT File>x: D:\Work\RAGTI_MRSSK2_SPM_LESS_FOC_TUNER_RV200\RAGTI_MRSSK2_SPM_LESS_FOC_TUNER_RV200.1mt — 0 |
Displays when the ) . .
File Option Help target is connected via Indicates the RMT file and Map file
that are loaded currently.
USB.
Connection File Information /
COM COM3 v Clock RMT File RAG6T1_MRSSK2_SPM_LESS FOC_TUNER RV... 4/5/2023 2:54:08 PM
Displays only for the
sample program Connect -- USB Serial Device Map File
provided by Renesas.
Configuration Select Tool
CPU RAGT1
Motor Type Brushless DC Motor Select a tool to start
from Select Tool.
Control Software for Tuner(Speed control)
Inverter RSSK for Motor Easy
Project File Path D:\Work\RABT1_MRSSK2 SPM_LESS FOC TUNER_RV200 v l“,' Details v
|
Name Date Modified Size
E;ﬁ_ RA6T1_MRSSK2_SPM_LESS_FOC_TUNER_RV200.rmt 2023/04/05 14:54:08 279 KB

Indicates the current project folder and
the RMT file included in it.

Figure 2-32 Main Window (after the target is connected)
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2.9.2 Basic GUI Operation
This section describes the basic GUI operations for Main Window and the internal tools (Easy, Analyzer, and
Tuner) of Renesas Motor Workbench.

For details on each function, refer to the Renesas Motor Workbench User’'s Manual.

(1) Tool switch button

When you launch a tool from Select Tool on Main Window, “Tool switch button” will be displayed on the top
of the screen of each tool. Click it to switch to another tool.

Note that you cannot switch tools during operating (driving a motor).
(2) Main Window switch button
"Main Window button” is shown on the upper right of the screen of each tool. Click it to go back to Main

Window.

Note that you cannot switch to Main Window during operating (driving a motor).

oM

Status

Configuration
CPU

Motor Type
Control

Inverter

COM3 v Clock RMTFile  RAGT1_MRSSK2_SPM_LESS i start the tool.)
Connect -- USB Serial Device Map File = /

Select Tool
RAGT1

@ Renesas Motor Workbench  <RMT File>:: D:\Work\RATI_MRSSKZ_SPM_LESS_FOC_TUNER_RV200\RAGTI_MRSSK2_SPM_LESS_FOC_TUNER_RV200.rmt - O X
File QOption Help
Connection File Information

Brushless DC Motor
Software for Tuner(Speed control)

RSSK for Motor

Project File Path  D:\Work\RAGT1_MRSSK2_SPM_LESS_FOC_TUNER_RV200 / v ‘,\\ Details v

Available tools are displayed. (Click to

Easy Analyzer
/

Click to go back
to Main Window.

Name

) RAGT1_MRSSK2_SPM_LESS_FOC_TUNER_RV200.rmt fhe Hew

9 Aaremas Mictor Workbmch  <RNIT Flae: CEVWerNRATT_ESE S LESS FOC E2% VIOMRAETI ES8 SPWLESE FOC EZS VIDLnme

Scope Window

LEY Save Load

Ref epesl

0

am

Easy tool

8 Wo Comrection CPLSeral | PORT

Shkard

sided

Figure 2-33 Tool switch button and Main Window button
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(3) Window view switch button

In the screen of each tool, you can change the window view by clicking the following buttons. You can also

release the maximized window.

You can select the frontmost window with the window list button (button (a) in the figure below). However,
when a window is framed out of the tool, the window is not displayed in the list of active windows. (In this

case, select the window from Windows Task Bar.)

<Window View Switch Button >

Main Window l_ |

) Display windows list (click to list windows)
) Arrange windows in cascade
(c) Arrange windows up and down
) Arrange windows side by side
) Back to original size (displayed only for the maximized window)

—'TTff

I
(@) (b) (c) (d) (e)

< Switching views by window list button (a) >

Click the window list button (a).

N\ |

Control Window

Main Window

Scope Window

User Button Control Window

Analyzer Navigation Window
List of currently displayed
windows

Select the frontmost
window.

Figure 2-34 Window view switch button in each tool window
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(4) Framing Out/In Window

You can move (frame out) tool windows (except for some tools) outside of the tool frame by dragging the
title. In reverse, you can return (frame in) the window to the original tool frame by dragging it.

@ Renesas Motor Workbench  <RMT File>:: C:¥e2¥RA6T1_ESB_SPM_LESS_FOC_E25_V101¥src¥applica ¥ics¥RAGT1_ESB_SPM_LESS_FOC_E25_ V101.rmt - o
File Help Easy Main Window
=1
o [& 231
Scope Window N
Zoom1 S
N
o~ A Y
Save Load All Trigger Status [ O] Scope Capture = Acquiring Data Cursors N
N
Time/Div | 200.00m ¥ Source cH3 | W Level 5269m 1 Position ( 19400m g So
Y
v A Y
N
N
AN
A Y
N\
N
N
Acquisition N
A Y
Length N\|
N\
N
Y
N
A Y
N
Y i *

o ou can move windows by ~
o mouse operation.
9
q_|

ChannelName

: g_f4_id_ref_mor

Ch #4: g_f4_id_ad_monitor

Save Load All

Time/Div  200.00m : Mode i W Edge Rise W Sourde CH3 W Level

-

\
\
\
\
\
\
\
\
\
\
\
\
\
\
\
\
\
\\ ChannelName /Div  OffSet Max Min Avg Ver-A Ver-B Hor-A Hor-B
\
\ d_est_monitor 500.00 0
\\ |_ref_monitor 200.00m O

id_ad_monitor 200.00m 0

52.69m

Frame-out
4

Zoom2

Cursors

a - ox e A
1§ Position ¢ 194.00m g

Graph Setting

Smoothing

Channel Setting

Set Color

Figure 2-35 Framing out and in window
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2.10 Saving RMT file and terminating Renesas Motor Workbench
The RMT file can be saved from “Save” or “Save As” of Main Window’s “File” menu.

Option Help

Open RMT File(0) Save the RMT file.
Save(s) /

Save As(A)
Load Variable Data(M)

EXit(X)

Figure 2-36 Saving RMT file

To terminate Renesas Motor Workbench, select “Exit” from Main Window’s “File” menu or press the close
button on the upper right corner of the screen.

On termination, the exit screen is shown as below.

Information

[Message]

Do you want to exit Renesas Motor Werkbench after saving the set information to
the RMT file?

[Message Code]

1-2-16

Save Save As No Save Cancel

Figure 2-37 Renesas Motor Workbench exit screen

The functions of each button on the exit screen are as follows.

Table 2-5 Functions of buttons on exit screen

Button Function

Save Saves the environment information of Renesas Motor Workbench into the loaded RMT
file by overwriting it and exits.

Save As Saves the environment information of Renesas Motor Workbench into a new RMT file
with a new name specified and exits.

No Save Exits without saving the environment information of Renesas Motor Workbench.

Cancel Cancel the termination process.
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3. How to Generate Map File

When Renesas Motor Workbench loads the global variable information (Map file) of the program written into
the MCU on the evaluation board, it gains access to the global variables. This Map file can be generated
together with the execution file (control software) in the program building.

The followings are setting procedures to generate a Map file in the Integrated Development Environment
“CS+ (CC compiler)”, “e? studio”, and “e? studio (RA)".

3.1 [RX] In CS+ (CC Compiler) Environment
Setting procedure:

Launch CS+ and display the target project. Open the project information from “Project Tree”.

Right-click on “CC-RX (Build Tool)” in “Project Tree” and select “Property”. The “Property” window will
be displayed on the right side of the screen.

Click “Link Options” in “Property”.
Open “List” and “Others”.

See “Outputs the linkage list file” under “List” and if it is set to “Yes (List contents=ALL)(-LISt -
SHow=ALL)”, skip to @ . If not, proceed to ®.

Select “Yes (List contents=specify) (-LISt)” to “Outputs the linkage list file” under “List”.

Select “No” to “Outputs a symbol name list in a module” under “List”.

Add “-Show=Symbol,struct” (comma-delimited) to “Other additional options” under “Others”.
Build with the above settings, and a Map file will be generated including “variable information”.

©WE® O O
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File Edit View Project Build Debug Tool Window Help B Property - x
& st | [ H @@ X G B30 o s & E =Y CCRX Propery ElEE
v List ~
SE PR E D83 Q5 @ Soluton List ( Quinuis he iinkags izt file YesiList contents=specfy}LISt) v
[ Project Tree Outputs 2 symbol name list imersaggle: No
H H Qutputs thy ber of symbol refe o N
) @2 @ @ Right-click on CC-RX. | bt "
Shows th toal sizes of sectons
= |RX72T MRSSK SPM LESS EQCTSP RV100 (Prc | Outputs vector information @ Open" List" and "Others".
S | 48 RSF572TKCxFB (MitTocontroller) Outputs relocation attributes related to sections
I PN CC-Rx (Build Toof ~ g""""""’" N NOOPt
5 RXE2 Lite (Debug] B 8114 Project 3 Opimzsiontype o optimze (NOOPtmize)
“D Pragram Analyze{ @ Rebuild Project ShiftsF7 —
JHE & Clean Project ( o iomioni N
? st aute ashcic use information e o
) :Z;: o Bl SettoDefault ® Select "Property". I E::‘ugr:saihedehuggmg information N N:(—Nocomwess)
L] driver T Import Build OPTERE Changes the information-level and error-level messages to warning-level me No.
[] config L Changes the information-level and warning-level messages to error-level me No.
il et Link Order. Deletes local symbol name information No
= Property ! Displays the total sizes of sections (oalTatalsizal.
| Displays the copyright irformation oA 3 o
5 Commands executed before lnk processing | 3 Select "Link Options" tab.
> Commands executed after link processing
QOther additional options =symbol .struct
> Command line Coftmand line[12] v
Outputs the inkage it le /
Selects whether to cutput the linkage lst e
This corresponds to the -list and -show option of the linker.
Common Options {_Compile Options /_AssembleOptionf : Link Options ( Hpx Output Options  _Library Generate Options -
Froperty - x
A, CC-RX Property al [o] [-][+
> Cinpi .
Output ® If itis setto "Yes (-LISt-Show=ALL)", proceed to
v et build
Outputs the linkage list file YesiList ALL)(-LISt -SHow=ALL) .
T
> Section .
> Veriy Otherwise
Property
w . _ : 3 Wil
ok Py ® Select "Yes (List contents=specify) (-LISt)" to "Outputs the
v Lt linkage list file".
Outputs the linkage list ile Yes(is contents=spechy ) LISt} I—-——-
Outputs 2 symbal neme listin 2 module No @ Select "No" to "Outputs a symbol name list in a module" under
Oulputs the number of symbol references No o
Outputs the cross-reference information No List".
Shaws the total sizes of sections No
Outputs vector information No
Outputs relocation atiributes related to sections No
v Optimization
Optimizziian type No cptimize(NOOPtmize)
> Section
> Verify
~ Others
Outputs 2 stack use information file No
Compresses the debugging information Nol-NOCOmpress)
Changes the warning-level and error-level messages to information-level me No
Chenges the information-level znd errar-level messages to warning-level me No
Changes the inf level and warning-level messages level me No
Deletes local symbol name information No
Displays the fofal sizes of sections Yes(-Tolal_size) M ” .
Displays the copyright information NotNOLOgo) Add “-Show=Symbol,struct” (comma-delimited) to
> Commands executed before link processing Commands exectted before lnk processing[0] "Other additional options" under "Other".
» Commands executed after link processing Commands exeouted afternk
Other additicnal opficns “show=symbol struct
> Command line Command Ine{12]
Other additional
Inputs the link aptions to be added addifionally.
The options set here are added at the end of the link options group.
Common Options | Compile Options / AssembleOptions ), Link Options | Hex Output Options Library Gen

Figure 3-1 CS+ (CC Compiler) property setting
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Tips : Copy a Map file to the location where a RMT file is saved after the build.
When you load a Map file after loading a RMT file, the dialog box is opened with the directory path of
the loaded RMT file specified. This is because the directory is opened that has been the most recently
operated in the file selection dialog box. Therefore, if you have copied a Map file to a RMT file
directory in advance, you can select the RMT/Map file without changing the directory path in the
dialog box.
In [Link Options] > [Others] > [Command executed after the build], enter the command as below to
copy the Map file to the directory where the RMT file is saved, and the Map file will be copied
automatically after the build.

copy %BuildModeName%\%ProjectName%.map app\rmw\%ProjectName%.map

B Property j main.c j r_mitr_config.h j r_mir_mod.c j r_mir_interrupt_carrier.c - X
4, CC-RX Property al [ol [=1[+
Changes the warning-level and error-level messages to information-level No ~

Changes the information-level and error-level messages to warning-level No
Changes the information-level and warning-level messages to error-level No

Deletes local symbel name information Mo
Displays the total sizes of sections Yes(-Total_size)
Displays the copyright information Mo(-NOLOgo)
Commands executed before link processing Commands executed before link processing[0]
N Commands executed after link processing[1]
L] 1 o | copy “-BuildModeName %4 Froject Name . map lb¥ics¥ % Project Name %.map ]
Other additional options . -show=symbol struct
Command line Command line[11]

Commands executed afier ink processing
Specifies the command to be executed after link control processing.
when specifying a batch file, use 3 call instruction like "call a.bat". 'When descnibed "#lpython” in the first line, the contents from the second line to the last line are e..

'\ Common Options ,{ Compile Options ,( AssembleOptions ,.i Link Options / Hex Output Options ,( Library Generate Options / -

Figure 3-2 Settings for copying Map file in CS+ (CC Compiler)

3.2 [RX] In e?studio Environment
Setting procedure:

Launch e? studio and display the target project.

Right-click on the target project from “Project Explorer” and select “Properties”. The
“Properties” window will be displayed.

Open “C/C++ Build” on the left and select “Settings”.
Select “Tool Settings” tab on the right from “Settings”.
Select “User” under “Linker”.

In “User-defined options (add after command line)” on the right bottom, press “+” button and
add “-Show=Symbol,struct” (comma-delimited)

Build with the above settings, and a Map file will be generated including “variable information”.

Q QO®® OO
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Q workspace - & studio

Project  Renesas Views

Run  Window

v | | [T RX72T_MRSSK_SP

File Edit Mavigate Search
(8]0 J[(m ] % e
B AR v & ¥

- v| #

45 Debug ||.1‘j Project Explorer X |

B Y § =8

v 1% RXT2T_MRSSK_SPM_LESS_FOC_E2S_RV100 [DefaultBuild] |

@

Select [Properties] from

right-click menu.
%, Binaries
[l Includes B System Explorer
== application @ Command Prompt
& config Configure >
= DefaultBuild
I Properties Alt+Enter I
A4
&) Properties for RX72T_MRSSK_SPM_LESS_FOC_EZS_RVI0D O x
type filter text Settings & -8
Resource
i ~
v CfC++ Build Configuration: | DefaultBuild [ Active] | [Manage Configurations...
Build Variables
Environment @
Logging & Tool Settings | Toolchain Device . Build Steps Build Artifact Binary Parsers € Error Parsers
Settings
Stack Analysis % Common User-defined options (added before all specified options) =R AR=RARU]
Tool Chain Editor & Compiler
C/C++ General B3 Assembler
Project Natures
Project References v nput
Renesas QF (8 Advanced
Run/Debug Settings ~ (& Output
Task Tags (& Advanced
Validation @ (2 List
(& Optimization
(£ Section Q Enter Value
(# Subcommand file
Miscellanecus User-defined options (added after all specified options)
5]
5 Tibrary Generator | -Show=Symbol,struct]
B3 Converter
@ Add option as
“-Show=Symbol, struct”.
Cancel

| — =]

User-defined options (added after all specified options)

_show=symbol,struct

Apply and Close

Cancel

Figure 3-3 e? studio property setting
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Tips: Copy a Map file to the location where a RMT file is saved.
When you load a Map file after loading a RMT file, the dialog box is opened with the directory path of
the loaded RMT file specified. This is because the directory is opened that has been the most recently
operated in the file selection dialog box. Therefore, if you have copied a Map file to a RMT file
directory in advance, you can select the RMT/Map file without changing the directory path in the
dialog box.
In [C/C++Build] > [Settings] > [Build Step] tab > [Post-build steps] , enter the command as below to
copy the Map file to the directory where the RMT file is saved, and the Map file will be copied
automatically after the build.

copy ${ProjName}.map ..\app\rmw\${ProjName}.map

4 l:}-pe filter text l Settings

Resource
Builders

C++ Build Configuration: |DefaultBuild [ Active]

Build Variables
Environment

Logging
Settings

Tool Chain Editor Pre-build steps
Command|(s):

& Tool Settings | Toolchain | Device | # Build Stezs Build Artifact| [si} Binary Parsers

C/C++ General
Project Natures
Project References

Description:

Renesas QE
oDty Post-build steps
Command(s):
Ié.-cop)* SIs{-.P-roJ:N:amé.}.map ...!-l-appgrmwg.s-{broj.f\iamé}.map |
Description:
Figure 3-4 Settings for copying Map file in e2studio
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3.3 [RA]In e?studio Environment
Setting procedure:

@ Copy “ElfMapConverter.exe” attached in Renesas Motor Workbench to the output folder of the

project.

@ Create a bat file that describes the following command. (The file can be named as any name.)
arm-none-eabi-objdump.exe -W project-name.elf>project-name.txt
ElfMapConverter.exe project-name.txt

@ Launch “e?studio” and display the project.

@ Right-click on the target project from “Project Explorer” and select “Properties”. The “Properties”

window will be displayed.

® Open “C/C++ Build” on the left and click “Settings”.

® Select “Build Steps” tab on the right in “Settings”.

@ Add the bat file created in @ to the command field of "Post-build steps". (The file is named “map.bat”

for example here.)

Build with the above settings, and a Map file (.rmap) will be generated including the “variable

information”.
g Properties for RAGT1_ESB_SPM_LESS_FOC_E25 V101 O X
Settngs Cro-y
RE.SUUKE n
%I Configuration: Debug [ Active] ~ |  Manage Configurations...
@ E Eu”_d Variables (& Orphaned configuration. No base extension cfg exists for com.renesas.cdt.managedbuild. gnuarm.config.elf.debug.1116803476
nvironment
LEIiiiﬂi 5 Tool Seﬁings* Build Artifact Binary Parsers @ Error Parsers
i::l‘n(sam Editor Pre-build steps @
C/C++ General Command(s):
Project Matures | ~ ‘
:;?:S(;Réf;ren:as Description:
Run/Debug Settings | v‘
Post-build steps
Command(s):
@ |map.baﬂ V|
Description:
| ~]
'(?:' Cancel
Figure 3-5 e? studio (RA) property setting
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Tips: Copy a Map file to the location where a RMT file is saved.
When you load a Map file after loading a RMT file, the dialog box is opened with the directory path of
the loaded RMT file specified. This is because the directory is opened that has been the most recently
operated in the file selection dialog box. Therefore, if you have copied a Map file to a RMT file
directory in advance, you can select the RMT/Map file without changing the directory path in the
dialog box.
In addition, if you have modified the extension of the Map file generated in this section from *.rmap to
*.map and copy the file, you do not need to change the file type in the dialog box for loading Map files.
If you add the command as below in the bat file described in the above step @), the Map file whose
extension has been modified will be copied automatically after the build. In the following example,

“ conv” is added to the copied Map file name so that you can identify the extension changed from
*.rmap to *.map.

copy ProjectName.rmap <RMT file save directory>\ProjectName_conv.map
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4. Communication Library

4.1 Communication Library for each MCU

To use Renesas Motor Workbench, it is necessary to include the communication library into a user program.
The communication library is provided in the package of Renesas Motor Workbench (in “communication
library” folder). Table 4-1 shows the communication libraries provided for each MCU.

Table 4-1 Communication library (for RX) 1/3

Supported CPU RX23T RX24T RX24U
File ics_RX23T.obj ics_RX24T .obj ics_RX24U.obj
ics_ RX23T.h ics_ RX24T.h ics_ RX24U.h

Communication rate

0.5 Mbps to 5 Mbps

Port

SCI1 TXD1:PD3
RXD1:PD5
SCI5 TXD5:PB5
RXD5:PB6
SCI5 TXD5:PB2
RXD5:PB1

SCI1 TXD1:PD3
RXD1:PD5
SCI5 TXD5:PB5
RXD5:PB6
SCI6 TXD6:PB2
RXD6:PB1
SCl6 TXD6:PBO
RXD6:PA5
SCI6 TXD6:P81
RXD6:P80

SCI1 TXD1:PD3
RXD1:PD5
SCI5 TXD5:PB5
RXD5:PB6
SCI6 TXD6:PB2
RXD6:PB1
SCIl6 TXD6:PBO
RXD6:PA5
SCI6 TXD6:P81
RXD6:P80

Supported variable type

8bit unsigned integer (number display/setting/waveform display)

8bit signed integer (number display/setting/waveform display)

16bit unsigned integer (number display/setting/waveform display)

16bit signed integer (number display/setting/waveform display)

32bit unsigned integer (number display/setting/waveform display)
32bit signed integer (number display/setting/waveform display)

32bit IEEE754 floating point (number display/setting/waveform display)

CPU resource to use

SCIx RX, SCIx TX, DTC
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Table 4-2 Communication library (for RX) 2/3

Supported CPU RX66T RX72T RX72M
File ICS2_RX66T.lib ICS2_RX72T.lib ICS2_RX72M.lib
ICS2_RX66T.h ICS2_RX72T.h ICS2_RX72M.h

Communication rate

0.5 Mbps to 7.5 Mbps

Port

SCI1 TXD1:PD3
RXD1:PD5
SCI5 TXD5:PB5
RXD5:PB6
SCIl6 TXD6:PBO
RXD6:PB1

SCI5 TXD5:PB5
RXD5:PB6
SCI6 TXD6:PBO
RXD6:PB1
SCI8 TXD8:PC1
RXD8:PCO0

SCIM12 TXD12:PB5

RXD12:PB6

SCIM1 TXD5:PFO
RXD5:PF2

SCI2 TXD6:P50
RXD6:P52

SCI3 TXD8:P23
RXD8:P25

SCl4 TXD8:PB1
RXD8:PB0O

SCI5 TXD5:PA4
RXD5:PA3

SCI6 TXD6:P00
RXD6:P01

SCI6 TXD8:PB1
RXD8:PB0O

SCI8 TXD12:PJ2
RXD12:PC6
SCI8 TXD12:PJ2
RXD12:PJ1

Supported variable type

8bit unsigned integer (number display/setting/waveform display)

8bit signed integer (number display/setting/waveform display)

16bit unsigned integer (number display/setting/waveform display)

16bit signed integer (number display/setting/waveform display)

32bit unsigned integer (humber display/setting/waveform display)
32bit signed integer (number display/setting/waveform display)

32bit IEEE754 floating point (number display/setting/waveform display)

CPU resource to use

SCIx RX, SCIx TX, DTC
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Table 4-3 Communication library (for RX) 3/3

Supported CPU RX13T RX26T
File ICS2_RX13T.lib ICS2_RX26T.lib
ICS2_RX13T.h ICS2_RX26T.h
Communication rate 0.5 Mbps to 4 Mbps 0.5 Mbps ~ 7.5 Mbps
Port SCI1 TXD1:PD3 SCI1 TXD1:PD3
RXD1:PD5 RXD1:PD5
SCI1 TXD1:PB6 SCI5 TXD5:PD7
RXD1:PB7 RXD5:PEO
SCI5 TXD5:PB6 SCI5 TXD5:PB5
RXD5:PB7 RXD5:PB6
SCI5 TXD5:PB2 SCl6 TXD6:P81
RXD5:PB1 RXD6:P80
SCI5 TXD5:P23 SCI6 TXD6:PB2
RXD5:P24 RXD6:PB1
SCI12 TXD12:PB0O SCI12 TXD12:PD4
RXD12:P94 RXD12:PD6
SCI12 TXD12:P01
RXD12:P00
SCI12 TXD12:P81
RXD12:P80
SCI12 TXD12:P23
RXD12:P22
SCI12 TXD12:PB5
RXD12:PB6

8bit unsigned integer (number display/setting/waveform display)
8bit signed integer (number display/setting/waveform display)
16bit unsigned integer (number display/setting/waveform display)
16bit signed integer (humber display/setting/waveform display)
32bit unsigned integer (number display/setting/waveform display)
32bit signed integer (number display/setting/waveform display)
32bit IEEE754 floating point (humber display/setting/waveform
display

SCIx RX, SCIx TX, DTC

Supported variable type

CPU resource to use
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Table 4-4 Communication library (for RL)

Supported CPU

RL78/G1F (R5F11BLE (64pin))

File

ics_ RL78G1F.obj
ics_RL78G1F.h
A file exists for every CA compiler and CC compiler.

Communication rate

0.5 Mbps to 5.33 Mbps

Port

SCI0 TXDO0:P51, RXD0:P50
SCI0 TXDO0:P17, RXD0:P16
SCI2 TXD2:P77, RXD2:P76

Supported variable
type

8bit unsigned integer (number display/setting/waveform display)
8bit signed integer (number display/setting/waveform display)
16bit unsigned integer (number display/setting/waveform display)
16bit signed integer (humber display/setting/waveform display)

CPU resource to use

DTC: *SCIx_Pab_Pcd

(x : SCI number, a/b/c/d : port number)

SCIx, PIORO0.1 (depending on the port)

PMCa.b, PMCc.d, Pa.b, PMa.b, PMc.d,

Pab (for TXDx), Pcd (for RXDx),

SPSO0 bit4 to 7 (clk),

STPROx, STPR1x, SRPR0x, SRPR1x, SREPROx, SREPR1x

Table 4-5 Communication library (for RA) 1/2

Supported CPU RAG6T1 RA6T2
File ICS2_RA6T1.0 ICS2_RA6T2.0
ICS2_RA6T1.h ICS2_RA6T2.h

Communication rate

0.5 Mbps to 7.5 Mbps 0.5 Mbps to 10.0 Mbps

Port

SCI9 TXD9:PD05
RXD9:PD06

SCI0 TXDO0:P101
RXDO0:P100
SCl4 TXD4:P205
RXD4:P206
SCI9 TXD9:P109
RXD9:P110

Supported variable
type

8bit unsigned integer (number display/setting/waveform display)
8bit signed integer (number display/setting/waveform display)
16bit unsigned integer (number display/setting/waveform display)
16bit signed integer (humber display/setting/waveform display)
32bit unsigned integer (number display/setting/waveform display)
32bit signed integer (number display/setting/waveform display)
32bit IEEE754 floating point (humber display/setting/waveform
display)

CPU resource to use

SCIx RX, SCIx TX | SCIx RX, SCIx TX
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Table 4-6 Communication library (for RA) 2/2

Supported CPU RAG6T3 RA4T1 RA8T1
File ICS2_RA6T3.0 ICS2_RA4T1.0 ICS2_RA8T1.0
ICS2_RA6T3.h ICS2_RA4T1.h ICS2_RA8T1.h

Communication rate

0.5 Mbps ~ 10.0 Mbps

0.5 Mbps ~ 10.0 Mbps

0.5 Mbps ~ 10.0 Mbps

Port

SCI0 TXDO0:P101
RXDO0:P100
SCI0 TXD0:P213
RXD0:P212
SCI0 TXDO0:P411
RXDO0:P410
SCI9 TXD9:P110
RXD9:P109

SCI0 TXDO0:P101
RXDO0:P100
SCI0 TXD0:P213
RXDO0:P212
SCI0 TXDO0:P411
RXDO0:P410
SCI9 TXD9:P110
RXD9:P109

SCHM TXD1:P213
RXD1:P212
SCI2 TXD2:PAO3
RXD2:PA02
SCI3 TXD3:P409
RXD3:P408
SCl4 TXD4:P714
RXD4:P715

Supported variable
type

8bit unsigned integer (number display/setting/waveform display)

8bit signed integer (number display/setting/waveform display)

16bit unsigned integer (number display/setting/waveform display)

16bit signed integer (number display/setting/waveform display)

32bit unsigned integer (humber display/setting/waveform display)
32bit signed integer (number display/setting/waveform display)

32bit IEEE754 floating point (number display/setting/waveform display)

CPU resource to use

SCIx RX, SCIx TX

| SCIx RX, SCIx TX

| SCIx RX, SCIx TX
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4.2 Built-in Type Communication Library

The RA6T2, RA6T3 ,RA4T1 and RA8T1 supports built-in type communication libraries. When using the built-
in type communication library, you can use a commercially available USB serial conversion module (isolated

type).

The built-in type communication library is included in the package of Renesas Motor Workbench (in
‘RABT2", “RABT3", “RA4T1” and “RA8T 1”folder in “communication library”).

Table 4-7 Built-in type communication library (for RA) 1/2

Supported CPU

RA6T2

RA6T3

RA4T1

File

ICS2_RA6T2_Built_in.o

ICS2_RAG6T3_Built_in.o

ICS2_RA4T1_Built_in.o

Communication rate

Port

SCI9 TXD9:PD05
RXD9:PD06

SCI0 TXDO0:P101
RXDO0:P100
SCI0 TXD0:P213
RXDO0:P212
SCI0 TXDO0:P411
RXDO0:P410
SCI9 TXD9:P110
RXD9:P109

SCI0 TXDO0:P101
RXDO0:P100
SCI0 TXD0:P213
RXD0:P212
SCI0 TXDO0:P411
RXDO0:P410
SCI9 TXD9:P110
RXD9:P109

Supported variable type

8bit unsigned integer (number display/setting/waveform display)

8bit signed integer (number display/setting/waveform display)

16bit unsigned integer (number display/setting/waveform display)

16bit signed integer (number display/setting/waveform display)

32bit unsigned integer (number display/setting/waveform display)

32bit signed integer (number display/setting/waveform display)

32bit IEEE754 floating point (humber display/setting/waveform display)

CPU resource to use

SCIx RX, SCIx TX

| sCIx RX, SCIx TX

| sCIx RX, SCIx TX

Table 4-8 Built-in type communication library (for RA) 2/2

Supported CPU

RA8T1

RXD1:P212
SCI2 TXD2:PAO3
RXD2:PA02
SCI3 TXD3:P409
RXD3:P408
SCl4 TXD4:P714
RXD4:P715

File ICS2_RA8T1 _Built_in.o
Communication rate -
Port SCI1 TXD1:P213

Supported variable type

8bit unsigned integer (number display/setting/waveform display)

8bit signed integer (number display/setting/waveform display)

16bit unsigned integer (number display/setting/waveform display)

16bit signed integer (number display/setting/waveform display)

32bit unsigned integer (number display/setting/waveform display)
32bit signed integer (number display/setting/waveform display)

32bit IEEE754 floating point (number display/setting/waveform display)

CPU resource to use

SCIx RX, SCIx TX
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4.3 How to Set User Program

431 DTC
Renesas Motor Workbench operates on a DTC (standard address mode), excluding RA MCUs. Therefore, it
is necessary to define the DTC table in a user program.

Reserve the area for the DTC table within a program (within a file to call initialization functions described
later).
e For RX microcontrollers
Assign the DTC table to an address in the RAM so that the lower 12bit becomes 0.
e For RL microcontrollers
Assign the DTC table to an address so that the lower 8bit becomes 0.

For code sample, refer to 4.3.4 How to Use Library Functions

When using an emulator such as E2, make sure that the user RAM area and the DTC table area do not
overlap.

4.3.2 Interruption
Specify the functions (ics_int_sci_eri(), ics_int_sci_rxi()) for the user program interrupt vectors as shown in
the code sample below (except for RA MCUs).

When using a project generated by the Renesas standard compiler with RX MCUs, specify them within
intprg.c.

void Excep_SCI1_ERI1 (void
void Excep_SCI1_RXI1 (void
void Excep_SCI5_ERI5 (void
void Excep_SCI5_RXI5 (void

{ ics_int_sci_eri(); }
{ ics_int_sci_rxi(); }
{ics_int_sci_eri(); }
{ics_int_sci_rxi(); }

~—~ ~— ~— —

Figure 4-1 Code sample for communication interruption functions
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4.3.3 Specification of Library Functions
In the communication library, the following two library functions are provided.

e void ics2_init(void* addr, char port, char level, char speed, char mode)
e void ics2_watchpoint(void)

The specifications of each function are shown below.

Table 4-9 Library function (ics2_init)

Function
name

void ics2_init(void* addr, char port, char level, char speed, char mode)

Return
value

void

None

Argument

void* addr

The start address of a DTC vector table to be used:
Users must reserve DTC vector table before calling this function.
*No settings of this argument for RA series

char port

Set SCI port number and pins used for SCI.

char level

Set SCl interrupt level:

Set the appropriate interrupt level for the system, since appx.10 psec
interrupt occurs within minimum 2 msec intervals.

*No settings of this argument for RA series

char speed

Set communication rate:
Set the value of the communication rate by the following expression.

e Communication rate = CLOCK/ (x x (speed + 1) ) [Mbps]

— CLOCK: The frequency of clock source supplied to SCI [MHZz]
RX: PCLK, RA: SCISPICLK or PCLK
*For details, see the MCU’s hardware manual.

— x: The fixed value for each MCU
For RX, RA6T1:x = 8
For RL78:x =2
For RA6T2, RA4T1, RA6T3, RA8T1:x =6

Ex.) When setting 1.0 Mbps for RX23T
CLOCK = PCLKB =40 [MHz], x = 8
then
1.0Mbps = 40MHz / (8 * (speed + 1) -> speed : 4

char mode

Set communication mode: specify 1

Function

Initialization process
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Table 4-10 Library function (ics2_watchpoint)

Function | void ics2_watchpoint(void)

name
Return void None
value

Argumen | void None
t

Function | Data transfer:

When the communication rate is BR [Mbps], the minimum sampling cycle is 70 + (180/BR)
[usec], and therefore the data transfer function is called at intervals greater than this value.
For example, 250 [usec] intervals or greater are required for communication rate at 1.0
[Mbps].

Note that when using a MC-COM (communication board for tools), the minimum sampling
cycle is 10 + (180/BR) [usec].
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4.3.4 How to Use Library Functions
(1) Calling on RX microcontroller

(a) Calling initialization function “ics2_init ()”
Add the initialization function “ics2_init” to the initialization process part of a program as shown in the
sample code below. Specify the argument based on the following rules.

The first argument:  specify the start address (0 for the lower 12 bit) of a DTC table
The second argument:select the port used from “ics_****.h” (see Table 4-1)

The third argument:  specify the tool interrupt level

The forth argument:  specify the communication rate

The fifth argument:  specify the transfer mode

#include "ics_RX23T.h"

#pragma section DTCTBL

unsigned long dtc_table[256]; /* caution alignment 0x000 */
#pragma section

void main(void)

{
}

ics2_init((void*) dtc_table, port, level, speed, mode);

Figure 4-2 Calling initialization function ics2_init() (RX23T sample code)

(b) Calling the data transfer function “ics2_watchpoint()”

Call the data transfer function “ics2_watchpoint()” at intervals longer than the minimum sampling cycle
as shown in the sample code below.

void int_TM100u(void) /* 100 psec interval */
{
if (3 <= g_u1_cnt_decimation) /* decimation of ICS call */
{
g_u1_cnt_decimation = 0;
ics2_watchpoint(); /* data transfer */
}

g_u1_cnt_decimation++;

Figure 4-3 Calling data transfer function ics2_watchpoint() (RX23T sample code)
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(2) Calling on RL microcontroller

(a) Calling initialization function “ics2_init()”
Add the initialization function” ics2_init” to the initialization process part of a program as shown in the
sample code below. Specify the argument based on the following rules.

The first argument:  specify the start address (0 for the lower 12 bit) of a DTC table
The second argument:select the port used from “ics_****.h” (see Table 4-2)

The third argument:  specify the tool interrupt level

The forth argument:  specify the communication rate

The fifth argument:  specify the transfer mode

#include "ics_ RL78G1F_ca.h"

#pragma address dtc_tbl = OxFFEOO
char dtc_tbl[0xDO0];

void main (void)

{
}

ics2_init((void*) dtc_table, port, level, speed, mode);

Figure 4-4 Calling initialization function ics2_init() (RL78/G1F sample code)

(b) Calling data transfer function “ics2 watchpoint()”

Call the data transfer function “ics2_watchpoint ()" at intervals longer than the minimum sampling cycle
as shown in the sample code below.

__interrupt void int. TM50u(void) /* 50 usec */
{ if (4 <= g_u1_cnt_decimation) /* decimation of ICS call */
{ g_u1_cnt_decimation = 0;
ics2_watchpoint(); [* data transfer */
};_u1_cnt_decimation++;
}

Figure 4-5 Calling data transfer function ics2_watchpoint() (RL78/G1F sample code)
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4.3.4.2 Calling on RA microcontroller

(a) Calling initialization function “ics2_init()”
Add the initialization function” ics2_init()” to the initialization process part of a program as shown in the
sample code below. Specify the argument based on the following rules.

The first argument:  select the port used from “ics_****.h” (see Table 4-3)
The second argument: specify the communication rate.
The third argument:  specify the transfer mode.

#include "ics2_RA6T1.h"

void main(void)

{
}

ics2_init(port, speed, mode);

Figure 4-6 Calling initialization function ics2_init() (RA6T1 sample code)

(b) Calling data transfer function “ics2_watchpoint()”
Call the data transfer function “ics2_watchpoint ()” at intervals longer than the minimum sampling cycle
as shown in the sample code below.

void int_ TM100u(void) /* 100 usec interval */
{
if (3 <= g_u1_cnt_decimation) /* decimation of ICS call */
{
g_u1_cnt_decimation = 0;
ics2_watchpoint(); [* data transfer */
}

g_ul_cnt_decimation++;

Figure 4-7 Calling data transfer function ics2_watchpoint() (RA6T1 sample code)
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Revision History

Revision
Rev. Date Page Contents
1.00 2023.05.30 - Issued as Quick Start Guide
1.01 2023.10.27 - Fixed 2.5.3 Acquiring New Authentication File
Changed the URL for obtaining the authentication file to the
RMW website.
1.02 2024.01.30 - Supported RA8T1

Ref: Revision history of old version of User's Manual (R21UZ0004)

Revision
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2.00 2018.11.27 - Released version 2.0
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2.02 2019.11.29 - Supported RX13T
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3.00 2021.12.09 - Released version 3.0
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Remarks

e This document is issued as “Quick Start Guide” by re-editing “Motor Control Development Support Tool
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— Renesas Motor Workbench Functional Description (R20AN0527)
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vin (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between ViL (Max.) and Vi (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.
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14.

(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2024 Renesas Electronics Corporation. All rights reserved.
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